
CS-32 Software User Guide
The CS-32 software allows you to map the controls on the CS-32 to perform various
functions such as sending MIDI messages, keystrokes and even communicating directly
with some applications. This software currently exists for the USB version of the CS-32
under Mac OS 9 and Mac OS X.

There is also a version for the MIDI CS-32 that runs under OS X. This MIDI software
adds features to the MIDI CS-32 that are not available from the hardware alone.

This guide covers all three versions.

Setup

CS-32 USB for Mac OS 9

Run the CS-32 Installer (OS9). The following files will be installed:

CS-32 USB Interface and CS-32 USB Shim in the System Folder•Extensions
folder. CS-32 Software in the Applications (OS 9) folder.
CS-32 Mixer Template.rns in your Reason•Template Songs folder.

The CS-32 USB software has the ability to make the CS-32 appear as a MIDI
device to OMS (Open Music System) compatible MIDI applications. To take
advantage of this ability, you need to place the file JLC OMS Driver in the
System Folder•OMS Folder.

CS-32 USB for Mac OS X

Run the CS-32 Installer. Depending on the options selected the following files
will be installed:

CS-32 folder containing the CS-32 application in /Applications.
CS32StartupItem in /Library/StartupItems.
CS-32 Mixer Template.rns in /Reason/Template songs/.



CS-32 MIDI for Mac OS X

Connect the CS-32 to MIDI interface connected to your Mac. You should follow
instructions that came with the interface for setting it up correctly.

Run the CS-32 MIDI Installer. Depending on the options selected the
following files will be installed:

CS-32 MIDI folder containing the CS-32 MIDI application in
/Applications.
CS32MIDIStartupItem in /Library/StartupItems.
CS-32 Mixer Template.rns in /Reason/Template songs/.

If you are going to be using Ableton Live™, follow the directions in the file
LiveKeysetInfo.pdf located in the CS-32•Third Party Support•Live™ folder.

Run the CS-32 application.

Use Import under the File menu to bring in keysets for any of the applications you want
to use the CS-32 with. The keysets are located in the Keysets folder in the same folder
containing the application. If a keyset doesn’t exist for your particular application, you
can create your own. Details on how to do this come later in this guide. Importing a
keyset is a one time operation. The application remembers which keysets have been
imported or created.

IMPORTANT: If you are using the CS-32 with Pro Tools LE 6 under Mac OS X you
should set the “Pro Tools LE Only” item under the MIDI Menu. Then you must restart
your Mac before running Pro Tools LE. If you are using a Pro Tools TDM system, you
do not need to use this option. This is discussed in more detail later in this guide.

There is one last step in setting up the MIDI Version of the CS-32. Go to Connections≤
under the MIDI Menu and choose the input and output ports that are connected to the CS-
32 hardware. DO NOT choose the ports labeled “CS-32 Software Out” or “CS-32
Software In.”

At this point you can quit the CS-32 application and try the CS-32 with the applications
for which you imported keysets, or you can read more about creating your own keysets.

Keysets

A keyset is a collection of actions to be performed each time one of the controls on the
CS-32 is pressed or turned. A different keyset can be created for each application that you
want to use the CS-32 with. The CS-32 software will use the correct keyset depending on
what application is front most at the time a control is pressed or turned.



You can either create a keyset from scratch or Import one as described above. An
imported keyset may be customized if you want to change its behavior.

To create a new keyset choose New Keyset… in the File Menu. Navigate to the
application that the keyset is to be used with then click on the Choose button. A new
empty keyset will be created, named after the application you chose. The keysets you
have created or imported will be listed in the Keysets Menu. You can use this menu to
choose a keyset to edit.

The first keyset in the Keysets Menu will always be “Default Keyset”. This tem will be in
the menu even if you haven’t created or imported any keysets. The default keyset is used
whenever the front most application has no keyset defined for it. Out of the box, the
Default keyset performs no actions.

Assigning Actions

The actions the CS-32 can perform are grouped into three main categories: MIDI,
Keystrokes and Special. There is a tab in the main window for each of these categories.
Here is the general procedure for assigning an action to a CS-32 control:

1) Click on the control’s onscreen graphic or press or turn the control on the CS-32.
The onscreen control will be highlighted and information about it will appear on
the upper right hand area of the main window.

2) Click on one of the three tabs and fill in the in the panel that appears.
3) Change the name of the control if you want.
4) Check or uncheck the “Latched” box. A button that is not latched will send an

“ON” message when pressed and an “OFF” message when released. A button that
is latched will send an “ON” message when pressed once and an “OFF” message
when pressed a second time. It will ignore button releases. The “Latched” setting
only applies to buttons.

5) Click on the Apply button.

MIDI TAB

The CS-32 USB version “speaks” the same MIDI protocol that the MIDI version does. It
just sends the data over a USB cable instead of a MIDI cable.  When you assign MIDI
actions to controls on a USB CS-32 the CS-32 appears to be a MIDI device to other
MIDI applications.

CS-32 MIDI Version Note: If you are using the CS-32 software to enhance your MIDI
CS-32, the CS-32 may appear twice in lists of MIDI devices. To connect your MIDI
applications to the CS-32, use the CS-32 Software IN and CS-32 Software Out. Do not
connect to the ports that the CS-32 hardware is plugged into. Those are only for the use
of the CS-32 software.



There are two main choices for the type of MIDI message a control will send. Native
MIDI and Custom MIDI. When Native MIDI is selected, the messages from the CS-32
will just be passed straight through to the receiving application(s). Custom MIDI allows
you to define any type of MIDI message except for System Exclusive. To make best use
of the Custom MIDI feature, it is recommended that you become familiar with the MIDI
Specification

If Custom MIDI is chosen, numerous other options become available. There is a popup
for choosing the basic type of message. Depending on the type of message chosen, fields
for setting the MIDI channel, first data byte and second data byte become available.

If “Follows Control’s Value” is checked next to one of the data bytes, then that byte’s
value will contain the value of the CS-32 control when the message is sent.

If you are editing a channel- based control (fader, mute, solo, etc…) you can assign the
same message to multiple channels, but have one byte incremented with each channel.
This saves a lot of editing. For example, say a Control Change on MIDI Channel 2 with
data byte 1 set to 0 and data byte 2 following the control value is assigned to Fader 1. If
you assigned the message to the next 7 channels, incrementing the 1st data byte, then
fader 2’s message would be a Control Change on MIDI Channel 2 with data byte 1 set to
1 and data byte 2 following the control value. Fader 8’s message would be a Control
Change on MIDI Channel 2 with data byte 1 set to 7 and data byte 2 following the control
value.

As a convenience, “Set All Controls to Native MIDI” under the Actions Menu assigns
Native MIDI messages to every control on the CS-32.

The CS-32 actually has more than one native protocol. This allows it to work “out of the
box” with applications which don’t specifically support it while also providing a protocol
designed for developers who want their MIDI applications to support the CS-32. There
are also protocols that emulate earlier JLCooper Control Stations so that applications
which support those devices will automatically support the CS-32.

The available protocols appear in the MIDI Menu. Each keyset can have it’s own
protocol and the CS-32 software will put the CS-32 into the correct mode depending on
the front most application. Following is a brief discussion of the CS-32 protocols:

Standard Mode, Enhanced Standard Mode

This is the “out of the box” mode. Many MIDI applications have the ability to “learn”
MIDI messages. That is, they can map incoming messages to control program functions.
Often the mapping can be done by selecting an onscreen function then sending the MIDI
message you want to control it. For example, in SequenceMaster 2003, you might go into
“Learn MIDI” mode, then click on the onscreen PLAY button then press the CS-32
PLAY button. From then on pressing the CS-32 PLAY button would put SequenceMaster
2003 into play. Different applications handle this differently, but this is the general idea.



Standard Mode is the best choice for these “Learn MIDI” applications.

Enhanced Standard Mode is not actually one of the CS-32 built-in protocols- it is an
enhancement done by the CS-32 software. It should be used when you want to control
channel functions such as SEND Levels and PANNING with the CS-32 pots. With
Enhanced Standard Mode active you can select the channel you want to work on with the
PAN/SELECT button for that channel. Then any movement of the CS-32 pots will
control functions on that channel.

JLCooper or third party application developers may have already created keysets and
MIDI templates for the applications you are using, but if you need to do it yourself, here
are the basic steps:

For the mythical application SequenceMaster 2003, first create a keyset in the CS-32
application. Choose “Set All Controls to Native MIDI” from the Actions Menu. Choose
Enhanced Standard Mode from the MIDI menu. You can quit the CS-32 application at
this point.

Run SequenceMaster 2003. Put it into “Learn MIDI” mode. Press PAN/SELECT for
channel 1 on the CS-32. Select an onscreen function such as PAN on channel 1. Turn the
Pan knob on the CS-32. Select the onscreen PAN for channel 2. Press PAN/SELECT for
channel 2 on the CS-32. Turn the Pan knob on the CS-32. Repeat for all channels. Repeat
for all channel functions that you want to control. Save as a template that can be used for
all future projects.

Again, the specifics will be different for each application, but the steps will be similar.

Host Mode

Host mode is similar to Standard mode but it allows developers more control over LED
displays and bank switching. You would normally not use it unless it is required by an
application you are working with. JLCooper or third party developers will often supply
keysets for applications which use this protocol.

CS-10 mode, CS-10 Bitmap mode

The CS-10 is a popular, well established member of the JLCooper control surface family
which is supported by many third party applications. The CS-32 can emulate the CS-10
protocols, thus allowing it to work with all of these applications.

You would normally not use either of these modes unless you know an application you
are working with supports them. JLCooper or third party developers will often supply
keysets for applications which use this protocol.



Pro Tools LE 6 Users Please Note

The last item in the MIDI Menu is “Pro Tools LE Only”. Due to the way that Pro Tools
LE 6 interacts with other MIDI applications that have been launched before Pro Tools,
the CS-32 software may not function correctly with Pro Tools LE under Mac OS X. If
you are using the CS-32 with Pro Tools LE 6, you should select "Pro Tools LE Only".
This will cause the CS-32 software to delay activating its MIDI ports until several
seconds after Pro Tools LE has launched. It will also deactivate its MIDI ports when Pro
Tools LE is shut down. This will let the CS-32 software perform correctly with Pro Tools
LE. The need for this feature is expected to go away with a future version of Pro Tools
LE. Mac OS 9 LE users and users of Pro Tools TDM systems under Mac OS 9 or OS X
do not need to use and SHOULD NOT use this feature.

Keystrokes TAB

The CS-32 software can also emulate the Macintosh keyboard. Most applications have
many functions that can be controlled from the keyboard.

Assigning a keystroke to a CS-32 control is simple. Click on an onscreen control or press
or turn the control on the CS-32. Then click in the text box labeled “Keystroke:”. Type
the desired keystroke, including modifier keys. The modifier key checkboxes will
automatically be checked or unchecked to show what modifier keys were pressed. The
modifier checkboxes can also be changed with the mouse. Click on the Apply button to
assign this keystroke.

NOTE: Some keystrokes and key combinations are intercepted by the operating system
before they reach the Keystroke text box. To enter these you will need to use different
modifier keys then adjust the modifiers with the mouse. For example, typing the
DELETE key will delete the text in the Keystroke box. To actually assign the DELETE
key you would have to type something like OPTION DELETE then uncheck the
OPTION key checkbox with the mouse. Other affected keystrokes and key combinations
include TAB, COMMAND O and COMMAND Q.

Special TAB

This tab contains a popup menu with three items, “No Action performed”, “Developer
Mode”, “and “JKL Shuttle Control”.

No Action Performed is used to clear any assignments from a control. For convenience,
choosing “Clear Keyset” from the Edit Menu will clear all controls.

Developer Mode is used by application developers who want to support the CS-32
without using MIDI. You would normally not use this mode unless you know an
application you are working with supports it. JLCooper or third party developers will
often supply keysets for applications which use this mode. As a convenience, “Set All



Controls to Developer Mode” under the Actions Menu assigns Developer Mode to every
control on the CS-32.

JKL Shuttle Control can only be assigned to the wheel when it is in shuttle mode. The
wheel is put into shuttle mode by pressing and releasing the SHUTTLE button. Pressing
and releasing the SHUTTLE button a second time will turn off shuttle mode. Some video
editing applications use the J, K and L keys on the Macintosh keyboard to control the
speed and direction of their transports and / or the transports of connected tape decks.
JKL Shuttle mode uses these keystrokes to emulate a smooth shuttle function with these
applications.

CS-32 Menus

File Menu

New Keyset… Create a keyset for a particular application from scratch. Previously
discussed under Keysets.

Import Keyset… Open an existing keyset file. Previously discussed under Keysets.

Export Keyset… Saves the currently selected keyset to a file. This is only used for
backup purposes or to move a keyset to another computer. Changes made to any keysets
in the CS-32 application are automatically saved to the CS-32 prefs file.

Edit Menu

Undo/Redo  Standard Macintosh Undo/Redo behavior.

Cut, Copy, Paste, Clear  Standard Macintosh editing commands. These apply to the
Name text field and to text fields in the MIDI and Keystrokes Tabs.

Cut Keyset, Copy Keyset, Paste Keyset, Clear Keyset  These work like the standard
Macintosh editing commands except that they apply to the entire contents of the currently
selected keyset.

Delete Current Keyset  This removes the currently selected keyset from the list of
keysets and from the CS-32 prefs file. If you want to keep a record of the current keyset
you should Export it before performing this operation.

Keysets Menu

This lists all of the keysets that are currently active. You can use this menu to select a
keyset for editing. Previously discussed under Keysets.



Actions Menu

Discussed previously. Contains convenience commands for assigning all controls to
either Native MIDI or Developer Mode.

MIDI Menu

Discussed previously. Used for setting the CS-32 hardware protocol and Pro Tools LE 6
compatibility.

CS-32 MIDI Version Note: “Connections” in this menu is where you go to connect the
CS-32 software to the CS-32 hardware.

Online Support

The latest software and support information for the CS-32 is available online at
http://www.jlcooper.com/pages/cs32support.html.
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